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BASS ist das Acronym für Basic Astronomical Spectroscopy Software und wurde von John Paraskeva 
entwickelt. Als freie Microsoft Windows basierte Anwendung ermöglicht BASS die vollständige Reduktion, 
Kalibrierung und eine weitgehende Auswertung von Spektren. 
  
https://groups.io/g/BassSpectro 

 

http://www.schuelerlabor-astronomie.de/
mailto:Bernd.Koch@astrofoto.de


 

            
 Schülerlabor Astronomie des Carl-Fuhlrott-Gymnasiums, Jung-Stilling-Weg 45, 42349 Wuppertal 
 www.schuelerlabor-astronomie.de | Kontakt: Dipl.-Phys. Bernd Koch | Bernd.Koch@astrofoto.de             2 

 

 
Kalibrierung eines 200 L/mm DADOS Sonnenspektrums (Tageslichtspektrum) mit 

Wellenlängenkalibrierung anhand der Fraunhoferlinien, Normierung und Flusskalibrierung  

1. BASS starten 
 

Dieses Tutorial setzt voraus, dass bereits ein Rohspektrum der Sonne (Foto) im Format FIT 

(C:/astrobodger/Sonne/Sonne.fit) vorliegt. Dieses wurde im Rahmen eines DADOS-Workshops mit MaxIm DL 

aufgenommen und vorbereitet. Das vorliegende Spektrum ist das mittlere, am höchsten aufgelöste Spektrum 

der drei mit einer Kamera abgebildeten Spektren (25m-Spalt). 

 

Start der aktuellen Version BASSProject.exe im Ordner C:\astroboger 

 

Das leere Arbeitsfenster eines neuen Projekts: 

 

BASS arbeitet mit „Projekten“, bei denen alle verwendeten Rohspektren (2D bedeutet Foto in zwei 

Dimensionen), Spektralprofile (1D bedeutet eindimensionaler Profilscan), Ergebnisse und Beschriftungen 

gespeichert werden. Projekte werden im Format .bass abgespeichert. BASS meldet sich, wenn Teile des 

Projekts (neue oder geänderte Spektralprofile) noch nicht gespeichert wurden und fordert dann dazu auf. 

Änderungen an vorhandenen oder neu erzeugte Spektralprofile werden im Format .fit (bzw. .dat) 

abgespeichert. Das FITS-Format ist besser als das DAT-Format, weil zusätzlich zu den Datenzeilen x,y auch alle 

wichtigen sonstigen Informationen gespeichert werden: Datum, Uhrzeit, Belichtungszeit, etc.  
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2. Arbeitsordner erstellen und Dateien kopieren 
 

➔ Öffne das Verzeichnis C:\astrobodger 

➔ Erstelle dort einen neuen Ordner Sonne 

➔ Kopiere das aufgenommene Sonnenspektrum Sonne.fit in den Ordner Sonne  

 

3. Die Aufnahme des Sonnenspektrums öffnen 

Öffne die Datei Sonne.fit   und wähle zur Ansicht diese Einstellung (Raw Image)  

Ergebnis: Das geöffnete Foto des Sonnenspektrums (2D) und das Spektrumprofil dieses Fotos (1D).   

 

 

Erläuterung: Die x-Achse („Pixels uncalibrated“) entspricht der Pixelposition in horizontaler x-Richtung auf dem 

Foto. Dieser Pixelwert muss in einen Wert für die Wellenlänge  (Lambda) umgerechnet werden. Diesen 

Vorgang bezeichnet man als Wellenlängenkalibrierung. 

Die y-Achse („Flux“) gibt die Intensität an einer bestimmten Pixelposition im 1D-Spektralprofil an. Diese 

Intensitätskurve wird auf zwei Arten kalibriert:  

a) Beseitigung des Pseudokontinuums (Normierung auf „1“). 

b) Absolutkalibrierung (= Flusskalibrierung) mit Hilfe eines Referenzspektrums.   
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4. Voreinstellungen vornehmen -> Edit Project Chart Settings 
 

Project Chart Settings: Hier alle Daten eingeben.  
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Chart width: 1100 / Chart height: 700 (hängt von der Größe des Bildschirms ab) 

 

… und am Ende das Speichern nicht vergessen → Apply → Ok 
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➔   Speichern des Projekts unter dem Namen c:/astrobodger/Sonne/Sonne.bass 

➔ Prüfen, ob Projekt korrekt gespeichert ist: New Projekt  → Open Project   

➔ Sonne.bass 
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5.  Das Sonnenspektrum horizontal ausrichten. 
 

➔ Image → Rotate/Tilt correction 

 

➔ Select Option → Draw Angle und Rotate Image wählen. 

Dann mit der Maus eine Line entlang des Spektrums ziehen. 

➔ Apply → Close 

Nun ist das Spektrum horizontal ausgerichtet. Hinweis: Im Falle geneigter oder gebogener Spektrallinien muss 

die Funktion Tilt Image bzw. Horizontal Smile ausgeführt werden. Das ist hier nicht der Fall. 
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➔ Abspeichern des soeben gedrehten Bildes: Save the selected image strip 

 

➔ Speichern unter dem selben Namen Sonne.fit 

➔ Speichern des Projekts:  unter dem selben Namen Sonne.bass 
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6. Auswahl des Scanbereichs -> Region Selection Tool 
 

➔ Selection → Region Selection Tool  

 

 

 

 

 

 

 

 

 

 

 

Es erscheint das Menüfenster Region Selection Tool.  

➔ Active Binned Region 
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Ziehe nun einen Rahmen innerhalb des Spektrums auf und verändere danach die Werte für Y Start und Y End, 

bis der Rahmen das Spektrum in nahezu voller Höhe umfasst. Die Breite wird automatisch angepasst. 

➔ Y Start → Y End → Update 

 

➔ Selection → Crop Image to Selection 

 

 

➔ Speichern des Projekts:  unter dem selben Namen Sonne.bass 
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7. Wellenlängenkalibrierung mit Linien des Sonnenspektrums 
 

➔ Enter Line Calibration Mode                             

➔ Erste Referenzline (O2-Linie bei 7605A) eng eingrenzen.        

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Wichtiger Hinweis:  

Die .dat-Dateien im Ordner Reference sind Wellenlängentabellen, die mit einem Editor verändert werden 

können. Falsche Wellenlängenwerte können korrigiert, neue hinzugefügt werden. 

Beispiel: Das Natrium-Dublett Na D1/D2 hat einen Abstand von nur 6Å, der bei niedriger Dispersion des Gitters 

nicht aufgelöst werden kann.  D1: 5889.951Å, D2: 5895.924Å. Beide Linien verschmelzen zu einer etwas 

dickeren Linie, so dass bei der Wellenlängenkalibrierung der Mittelwert der beiden verwendet wird. Dieser 

Mittelwert 5892.94Å ist der Datei hinzugefügt worden. 

Die Wellenlängenreferenz LambdaData.dat wurde vom Autor editiert und unterscheidet sich in einigen 

Einträgen von der Originaldatei. Die Originaldaten wurden vom Autor der Software ursprünglich aus VisualSpec 

importiert.  
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➔ Erste Referenzline (O2-Linie bei 7605A) mit der Maus eng eingrenzen. Elementfilter: Oxygen  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

O2          
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➔ Zweite Referenzlinie:  → Add Annother Point → H-Linie mit der Maus eng eingrenzen 

 

 

 

 

 

  

  H   

O2          
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➔ Dritte Referenzline: → Add annother Point: Na D1 und Na D2 verschmelzen wegen der niedrigen 

Auflösung des 200L/mm Gitters zu einer verbreiterten Linie. Daher den Mittelwert beider wählen:  

Na D1: 5889.95Å und Na D2: 5895.924Å → Mittelwert: 5892.94Å 

 

  

O2          

  H   
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➔ Vierte Referenzlinie: → Add Another Point -> H-Linie eng eingrenzen → Suggest schlägt Linie vor: 

 

 

Calibration fit von 1 Linear auf 2 Quadratic umstellen:→ RMS auf 0,79A verringert. 

  

   H   
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➔ Fünfte und letzte Referenzlinie: Kalzium-Linie K 3968.33Å 

  

   Ca II K  
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➔ Finish: Ein Polynom 3. Grades (Cubic) ergibt einen akzeptablen Restfehler von RMS=0.16Å 

 

 

 

 

 

 

 

 

 

 

 

 

 

➔ Image Strip View umstellen auf Synth Color stretched (synthetisches Sonnenspektrum) 

➔ Speichern des Projekts:  unter dem selben Namen Sonne.bass 
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➔ Show/Hide Calibration Points: Schaltet nur die Anzeige der Kalibrierpunkte aus! 

 

 

 

 

 

 

 

 

 

 

 

 

Und hier ist das fertig wellenlängenkalibrierte Sonnenspektrum! 

➔ Rechte Maustaste: Show legend here 
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8. Kalibrierung der Intensität des Spektrums 
Der Intensitätsverlauf des wellenlängenkalibrierten Spektrums stellt nicht den wahren Kontinuumsverlauf dar. 

Dieser wird durch verschiedene Faktoren verfälscht. Dazu zählt die Instrumentenfunktion („Response“) von 

Teleskop, Spektrograf und Kamera, sowie Absorption und Streuung an interstellarem Staub und Molekülen in 

der Erdatmosphäre. Zusammengefasst spricht man von einem Pseudokontinuum.  

Auf zwei verschiedene Arten können diese Einflüsse beseitigt werden: Normierung auf „1“ oder 

Flusskalibrierung. 

8.1 Normierung des Spektrums 
Unter der Normierung eines Spektrums versteht man die Eliminierung des pseudokontinuierlichen Anteils im 

Spektrum, so dass nur noch die Spektrallinien im Spektrum verbleiben.  

Subtraktion des Kontinuums: Hat den Nachteil, dass bei einer Subtraktion die relativen Intensitäten der 

Spektrallinien zueinander nicht stimmen. Wird in der Regel nicht angewendet. 

Division durch das Kontinuum: Die relativen Intensitäten bleiben erhalten, das Divisionsergebnis ergibt im 

Spektrum im Idealfall einen exakt horizontalen Verlauf, dessen Intensität den Wert „1“ aufweist. Deshalb 

spricht man auch von der Normierung auf „1“. Dies wird im Folgenden beschrieben. 

Durchführung einer Normierung: 

➔ Continuum and Response Shaper anwenden auf  

01 Sonne.fit 

 

 

 

 

 

 

➔ Kästchen setzen per Doppelklick entlang des Kontinuums. Kästchen löschen 

mit mittlerer Maustaste. Spektrallinien überbrücken, ohne die Flügel der 

Linien zu kappen. Die so definierte orangene Kurve ist die sogenannte 

Instrumentenfunktion, meist auch als Response bezeichnet. 
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Die orangene Kurve ist die Instrumentenfunktion (Response) 

 

➔ Save as Continuum Removal for: 01 Sonne.fit 

 

➔ Normierung direkt anwenden: Abfrage mit Ok beantworten 
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➔ Falls das durchschnittliche Kontinuum NICHT auf einer horizontalen Linie liegt, kann die Datei 

response_norm.dat verändert werden. 

➔ Edit 

 

 

 

 

 

 

 

 

 

 

➔ Neue Kästchen können gesetzt oder alte entfernt werden 

 

➔ Save Continuum Removal 

 

➔ Ok 
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➔ Ergebnis: Ein normiertes Spektrum mit (nahezu) horizontalem Kontinuum 

 

➔ Ansicht Vorher/Nachher: Wie sieht das Profil mit bzw. ohne Kontinummsbeseitigung aus?  

 

➔ Profile Properties  

➔ Response 

➔ Continuum Removal <-> No Response Correction 

 hin- und her schalten 
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Kalibrierung eines 200 L/mm DADOS Sonnenspektrums (Tageslichtspektrum) mit 

Wellenlängenkalibrierung anhand der Fraunhoferlinien, Normierung und Flusskalibrierung  

Unerwünschte Bereiche links und rechts des Spektrums können ausgegrenzt werden. Ein vollständiges 

abschneiden ist aber nicht möglich!! 

➔ Mit der linken Maustaste das 

Spektrum wie gewünscht 

eingrenzen 

 

➔ Crop X-Axis Range  

 

➔ Wellenlängenwerte ggf. anpassen 

 

 

 

 

 

 

➔ Ok 

 

 

 

 

➔ Eingeblendete Kalibrierlinien (zur Prüfung) einblenden: Calibration Show / Hide Calibration Points: 
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Kalibrierung eines 200 L/mm DADOS Sonnenspektrums (Tageslichtspektrum) mit 

Wellenlängenkalibrierung anhand der Fraunhoferlinien, Normierung und Flusskalibrierung  

8.1.1 Normierung auf „1“ 
„Normierung auf 1“ bedeutet, dass das Kontinuum auf den Wert 1 festgelegt wird. Die rote Linie wurde hier 

in dem Bild per Hand eingezogen, um zu zeigen, wo ungefähr das Intensitätsniveau 1 liegen soll 

 

 

Normierung auf „1“ durchführen: 

➔ Image  

➔ Normalize Flux Scale 

➔ Spektrum dahingehend sichten, dass man einen Bereich definieren kann, der den Wert 1 erreichen soll. 

Hier 6600Å-6700Å 
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Kalibrierung eines 200 L/mm DADOS Sonnenspektrums (Tageslichtspektrum) mit 

Wellenlängenkalibrierung anhand der Fraunhoferlinien, Normierung und Flusskalibrierung  

Prüfen, ggf. neue Start- und Endwerte eingeben. Die rote Linie wurde zur Ansicht per Hand eingezogen. 

Die Normierung passt nicht perfekt im UV-Bereich. Das kann man verbessern, indem man die Response-Datei 

editiert und neue Kästchen für das Kontinuum setzt. Für unsere Zwecke ist die Normierung jedoch ausreichend 

gut. 

 

 

➔ Manuelle Skalierung der Y-Achse (Flux) von 0 bis 1.2:  

 

➔    
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Kalibrierung eines 200 L/mm DADOS Sonnenspektrums (Tageslichtspektrum) mit 

Wellenlängenkalibrierung anhand der Fraunhoferlinien, Normierung und Flusskalibrierung  

➔ Ergebnis: Das auf „1“ normierte Sonnenspektrum, in der Intensität von 0 bis 1.2 skaliert. 

 

 

Hinweis: Die Normierung auf „1“ ist ein höchst subjektiver Vorgang, der von jedem Bearbeiter durchgeführt 

und beurteilt wird.  

8.1.2 Die Fraunhoferlinien im Sonnenspektrum  
 

Tabelle: Richard Walker 

 

 

 

 

 

 

 

 

 

 

 

 

 

Joseph von FRAUNHOFER (1787 - 1826) 

https://de.wikipedia.org/wiki/Fraunhoferlinie 
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Symbol Element Wellenlänge (A) Symbol Element Wellenlänge (A) 

Y O2 8987,65 c Fe 4957,61 

Z O2 8226,96 F Hβ 4861,34 

A-Band O2 7593,70 d Fe 4668,14 

B-Band O2 6867,19 e Fe 4383,55 

C Hα 6562,81 G' Hγ 4340,47 

a O2 6276,61 G Fe 4307,90 

D1 Na 5895,94 G Ca 4307,74 

D2 Na 5889,97 
g 

h 

Ca 

Hδ 

4227 

4101,75 

D3 He 5875,62 H Ca II 3968,47 

E Fe 5270,39 K Ca II 3933,68 

b1 Mg 5183,62 L Fe 3820,44 

b2 Mg 5172,70 N Fe 3581,21 

b3 Fe 5168,91    

b4 Fe 5167,51    

b4 Mg 5167,33    

      

Die Fraunhofer C-, F-, G'- und h-Linien stimmen mit den alpha-, beta-, gamma- und delta-Linien der 
Balmer-Serie eines Wasserstoffatoms überein. 

Die Linien A, B, a, Y und Z sind nicht solaren, sondern terrestrischen Ursprungs, das heißt: Sie 
entstehen durch Absorption in der Erdatmosphäre.  
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8.1.3 Beschriftung des normierten Spektrums 
 

➔ Add Label to chart -> Manage Labels -> Load Set 

➔ Labelset Sonne.lbl öffnen 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Y 
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Kalibrierung eines 200 L/mm DADOS Sonnenspektrums (Tageslichtspektrum) mit 

Wellenlängenkalibrierung anhand der Fraunhoferlinien, Normierung und Flusskalibrierung  

 

8.1.4 Speichern: Projekt – Profil – Chart – Image Strips 

➔ Speichern des Projekts mit allen Skalierungen und Beschriftungen:  (Sonne.bass) 

 

➔ Speichern des Spektralprofils (_1D), um es bsp. in 

VisualSpec zu verarbeiten:  (.fits) 

 

 

 

 

 

 

➔ Speichern des synthetischen Spektrums: 
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Kalibrierung eines 200 L/mm DADOS Sonnenspektrums (Tageslichtspektrum) mit 
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Kalibrierung eines 200 L/mm DADOS Sonnenspektrums (Tageslichtspektrum) mit 

Wellenlängenkalibrierung anhand der Fraunhoferlinien, Normierung und Flusskalibrierung  

Ein farbiges Spektralband im Hintergrund erzeugen 

➔ Background colour 

➔ Wavelength Colour blend 
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Kalibrierung eines 200 L/mm DADOS Sonnenspektrums (Tageslichtspektrum) mit 

Wellenlängenkalibrierung anhand der Fraunhoferlinien, Normierung und Flusskalibrierung  

 

➔ Synthetisches Spektrum speichern: Chart -> Save Image Strips to file … 

 

➔ Synthetisches Spektrum als Hintergrundbild 

 

 

 

 

 

➔ Save Chart to file 
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Kalibrierung eines 200 L/mm DADOS Sonnenspektrums (Tageslichtspektrum) mit 

Wellenlängenkalibrierung anhand der Fraunhoferlinien, Normierung und Flusskalibrierung  

8.2 Flusskalibrierung mit einem kalibrierten Referenzstern 
 

Unter dem Begriff der Flusskalibrierung versteht man eine Intensitätskalibrierung, die die relative Intensität 

bei der jeweiligen Wellenlänge korrekt wiedergibt. Relativ auf das Maximum bezogen, nicht in absoluten 

physikalischen Einheiten. 

Falls bereits eine Normierung durchgeführt wurde, greifen wir auf die auf „1“ normierte Datei sonne.bass 

zurück. 

Wir deaktivieren die Beschriftung und Normierung: No Response Correction: 

 

 

 

 

 

 

 

 

 

 

Und erhalten als Ausgangspektrum dieses wellenlängenkalibrierte, jedoch nicht Intensitätskalibrierte 

Spektrum: 

 

Nun wird ein neues Projekt gespeichert: 

➔ Save Project File 

➔ C:\astrobodger\Sonne\Sonne_fluxcalibrated.bass 
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Kalibrierung eines 200 L/mm DADOS Sonnenspektrums (Tageslichtspektrum) mit 

Wellenlängenkalibrierung anhand der Fraunhoferlinien, Normierung und Flusskalibrierung  

8.2.1 Öffnen eines flusskalibrierten Referenzspektrums 
Um die Intensität absolut kalibrieren zu können, ziehen wir ein bereits flusskalibriertes Spektrum eines Sterns 

heran. Aber nicht ein beliebiges, sondern eines von einem Stern desselben Spektraltyps wie die Sonne, also 

G2V. 

➔ Tools 

➔ Reference Spectrum 

 

 

 

 

 

 

 

 

 

 

 

 

 

➔ Pickles-Datenbank. Wähle g2v.  

➔ Add Spectrum to chart 

➔ Close 
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Kalibrierung eines 200 L/mm DADOS Sonnenspektrums (Tageslichtspektrum) mit 

Wellenlängenkalibrierung anhand der Fraunhoferlinien, Normierung und Flusskalibrierung  

 

Das hier grün dargestellte Spektrum ist ein vollständig flusskalibriertes Spektrum, aus dem die auf Absorption 

in der Erdatmosphäre beruhenden tellurischen Linien/Banden des Sauerstoffs und Wasserdampfs bereits 

entfernt worden sind.  

 

Skalierung der Y-Achse in Spektrum 01 und 02 stellen auf: Scale als first profile „Wie das erste Spektrum“ und 

speichern 

 

➔ Profile Properties  

  

Tellurische Linien 
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Kalibrierung eines 200 L/mm DADOS Sonnenspektrums (Tageslichtspektrum) mit 

Wellenlängenkalibrierung anhand der Fraunhoferlinien, Normierung und Flusskalibrierung  

Zur Ermittlung der Instrumentenfunktion („Response“) werden beide Spektren 

nun durcheinander dividiert: 

 

➔ Perform this operation: Divide Profiles 

 On this Profile: 01: Sonne.fit 

 Using this profile: 02 G2V Reference Spectrum 

 Divisionsergebnis: 03 Divide Profile Sonne.fit by G2V Reference Spectrum 
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Kalibrierung eines 200 L/mm DADOS Sonnenspektrums (Tageslichtspektrum) mit 

Wellenlängenkalibrierung anhand der Fraunhoferlinien, Normierung und Flusskalibrierung  

03 Divide Profile Sonne.fit by G2V Reference Spectrum muss aktiv sein. 

 

➔ Continuum & Response Shaper: Punkte setzen entlang des Spektrums 03. 

 

 

 

 

 

 

 

 

 

 

 

➔ Save 

➔ Save as response DAT file …  

➔ response_flux.dat 

➔ close 
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Kalibrierung eines 200 L/mm DADOS Sonnenspektrums (Tageslichtspektrum) mit 

Wellenlängenkalibrierung anhand der Fraunhoferlinien, Normierung und Flusskalibrierung  

 

➔ Die Datei response_flux.dat ist das geglättete Divisionsergebnis und stellt nun eine Korrektur dar, die 

wir auf das Spektrum der Sonne 01 anwenden müssen: 

 

8.2.2 Flusskalibrierung mit Datei response_flux.dat 
 

Bildschirm aufräumen: Spektren Nr. 02 und Nr. 03 

ausblenden („Hide Profile from Chart“): 

 

➔ Nr. 2 ausblenden: Hide Profile from Chart 

 

➔ Nr. 3 ausblenden: Hide Profile from Chart 

 

➔ Nr. 1 muss aktiviert sein 
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Kalibrierung eines 200 L/mm DADOS Sonnenspektrums (Tageslichtspektrum) mit 

Wellenlängenkalibrierung anhand der Fraunhoferlinien, Normierung und Flusskalibrierung  

➔ Profile Properties: 01 Sonne.fit 

➔ Response File: response_flux.dat öffnen 

➔ Apply 

 

 

 

 

 

 

 

 

 

 

 

➔ Ergebnis: Das eigene flusskalibrierte Sonnenspektrum 

Man kann nun hin- und herschalten zwischen:  

 

➔ No Response Correction (aufgenommenes Sonnenspektrum) 

➔ Response File (flusskalibriert, Flux) 

➔ Continuum Removal (Normierung auf 1) 
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Kalibrierung eines 200 L/mm DADOS Sonnenspektrums (Tageslichtspektrum) mit 

Wellenlängenkalibrierung anhand der Fraunhoferlinien, Normierung und Flusskalibrierung  

8.2.3 Speichern: Projekt – Profil – Chart – Image Strips 
 

➔ Save Project File 

 

 

 

 

 

 

 

 

 

 

 

 

 

Falls eine andere Speicheraufforderung kommt, bitte erst mit Diskettensymbol speichern: 

➔ Save the selected image strip (hier: Spektrum Nr. 03).  

➔ Danach Save Project file (siehe oben). 
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Kalibrierung eines 200 L/mm DADOS Sonnenspektrums (Tageslichtspektrum) mit 

Wellenlängenkalibrierung anhand der Fraunhoferlinien, Normierung und Flusskalibrierung  

8.2.4 Skalierung der flusskalibrierten Y-Achse und Vergleich mit Referenzspektrum 
 

➔ Profile Properties: 

➔ 01: Sonne.fit -> Automatic Scaling 

➔ 02: G2V Reference Spectrum -> Scale as first profile 

Abweichungen in der Intensität beruhen ausschließlich darauf, dass bei der Glättung nach der Division die 

Punkte nicht exakt auf das Spektrum gesetzt wurden. Der Kontinuumsverlauf muss identisch sein, nur die Tiefe 

der Absorptionslinien kann unterschiedlich sein. 
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Kalibrierung eines 200 L/mm DADOS Sonnenspektrums (Tageslichtspektrum) mit 

Wellenlängenkalibrierung anhand der Fraunhoferlinien, Normierung und Flusskalibrierung  

8.2.5 Flusskalibrierung mit einem Spektrum aus der MILES-Datenbank: 
➔ MILES-Datenbank. Wähle g2v s0733hd186408_dered. HD186408 ist die Katalognummer des Sterns. 

„dered“ bedeutet, dass das Spektrum „entrötet“ wurde. Darunter versteht man die Korrektur der 

Intensität in Bezug auf den Einfluss des interstellaren Staubes. Dieser schwächt blaues Licht stärker ab 

als rotes Licht, so dass der Rotanteil vergleichsweise zu hoch ist, das Spektrum also „ent-rötet werden 

muss.   

➔ Add Spectrum to Chart 

➔ Close 

Das hier grün dargestellte Spektrum ist ein vollständig flusskalibriertes Spektrum, aus dem die auf Absorption 

in der Erdatmosphäre beruhenden tellurischen Linien/Banden des Sauerstoffs und Wasserdampfs bereits 

entfernt worden sind. Der Infrarotbereich (rechts) ist nicht berücksichtigt. 

Die Kalibrierung mit dem MILES-Spektrum wird im Folgenden nicht zuende geführt.  
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8.2.6 Beschriftung des flusskalibrierten Spektrums 
 

➔ Add Label to chart -> Manage Labels -> Load Set 

➔ Labelset Sonne.lbl öffnen 

 

 

 

 

 

 

 

 

Die Einträge in diesem Labelset sind editierbar! Man kann weitere Einträge vornehmen. 

➔ Save Set: Labelset Sonne flusskalibriert.lbl 
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8.2.7 Abspeichern des beschrifteten Spektrums (Save Chart to file) 
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8.2.8 Anpassung einer Planckschen Strahlungskurve 
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9. Übertragung des Projekts an einem anderen Ort („Bundles“) 
 

BASS arbeitet projektbezogen. Das bedeutet, dass alle für das Projekt benötigten oder erstellten Dateien einen 

festen Pfad besitzen und im Ordner c:/astrobodger/ … vorhanden sein müssen. Deshalb findet die Kalibrierung 

gemäß Tutorial ausschließlich im Ordner c:/astrobodger/Sonne statt.   

Im Ordner Musterkalibrierung ist die komplette Kalibrierung mit Hilfe einer weiteren Funktion zur Ansicht 

separat abgespeichert worden. Die Musterkalibrierung kann unter dem Namen Sonne.bass bzw. 

Sonne_fluxcalibrated.bass aufgerufen und im Detail betrachtet werden.   

Frage: Wie überträgt man die ursprüngliche Kalibrierung .bass von c:/astrobodger/ … auf eine andere 

Festplatte und/oder in einen anderen Ordner, um sie von dort aus aufrufen zu können?  

Antwort: Man öffnet wie gewohnt in c:/astrobodger/Sonne die BASS-Datei (Beispiel: 

Sonne_fluxcalibrated.bass und speichert das Projekt im neuen Ordner wie folgt als „Bundle“ ab: 

Speichern als Bundle: File -> Save Project or Bundle -> I:/…./Sonne_fluxcalibrated.bun 

Entpacken des Bundles am neuen Ort I:/…./Musterkalibrierung: File -> Open Project or Bundle -> 

Sonne_fluxcalibrated.bun 

 

 

Entpacken des Bundles am neuen Ort:  

Dort öffnet man die .bass-Datei des Projekts und arbeitet wie gewohnt weiter. 
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10. Kurse zur Sternspektroskopie am CFG Wuppertal 
Das vorliegende Tutorial zur Kalibrierung eines 

Sonnenspektrums (Tageslichtspektrum) wird in den 

Kursen des Autors (rechts im Bild) am Carl-Fuhlrott-

Gymnasium in Wuppertal zur Sternspektroskopie 

eingesetzt. Im Rahmen des Kurses wird u.a. das 

Tageslichtspektrum mit insgesamt sieben zur 

Verfügung stehenden DADOS-Spektrografen und 

ebenso vielen STF-8300M CCD-Kameras aufgenom-

men und für die Kalibrierung mit BASS vorbereitet.  

Die seit 2011 verwendete Software VisualSpec wird 

nur noch hin- und wieder herangezogen.  

Aktuelle Kursinformationen finden Sie unter:  

https://www.baader-planetarium.com/de/blog/aktuelle-spektroskopie-kurse-am-schuelerlabor-astronomie/ 
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